
BAB II

TINJAUAN PUSTAKA

2.1 Mikrokontroler

Mikrokontroler  merupakan  sebuah  prosesor  yang  digunakan  untuk

kepentingan kontrol. Meskipun mempunyai bentuk yang jauh lebih kecil dari suatu

komputer pribadi dan komputer mainframe, mikrokontroler dibangun dari elemen-

elemen  dasar  yang sama.  Seperti  umumnya  komputer,  mikrokontroler  adalah  alat

yang  mengerjakan  instruksi–instruksi  yang  diberikan  kepadanya.  Artinya,  bagian

terpenting dan utama dari suatu sistem terkomputerisasi  adalah program itu sendiri

yang dibuat oleh seorang programer. Program ini mengisntruksikan komputer untuk

melakukan tugas yang lebih kompleks yang di inginkan oleh programmer. Menurut

Sumardi(2013:1).

Beberapa fitur yang umumnya ada di dalam mikrokontroler adalah sebagai berikut: 

1. ROM (Read Only Memory)

ROM  berfungsi  untuk  tempat  penyimpanan  variable.  Memori  ini  bersifat

volatile  yang berarti  akan kehilangan semua datanya jika  tidak memdapat

catu daya.

2. RAM (Random Access Memory) 

RAM digunakan oleh mikrokontroler untuk tempat penyimapan program yang

akan diberikan oleh user

3. Register 

Merupakan  tempat  penyimpanan  nilai  –  nilai  yang  akan  digunakan  dalam

proses yang telah disediakan oleh mikrokontroler.

4. Special Function Register

Merupakan  register  khusus  yang  berfungsi  untuk  mengatur  jalanya

mikrokontroler. Register ini terletak pada RAM.

5. Input dan Output Pin
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Pin input adalah bagian yang berfungsi sebagai penerima signal dari luar, pin

ini dapat dihubungkan ke berbagai media inputan seperti keypad, sensor, dan

sebagainya.  Pin  output  adalah  bagian  yang  berfungsi  untuk  mengeluarkan

signal dari hasil proses algoritma mikrokontroler.

6. Interupt

Interupt  adalah  bagian mikrokontroler  yang berfungsi  sebagai  bagian yang

dapat  melakukan interupsi,  sehinga ketika program utama sedang berjalan,

program utama tersebut dapat di interupsi dan menjalankan program instrupsi

terlebih dahulu. 

Beberapa interupt pada umumnya adalah sebagai berikut :

1. Interupt eksternal

Interupt akan terjadi bila ada inputan dari pin interupt.

2. Interupt timer

Interupt akan terjadi bila waktu tertentu telah tercapai.

3. Interupt serial

Interupt yang terjadi ketika ada penerimaan data dari komunikasi serial.

Rata-rata  mikrokontroler  memiliki  instruksi  manipulasi  bit,  akses  ke  I/O

secara langsung dan mudah, dan proses interupt yang cepat dan efisien. Dengan kata

lain mikrokontroler adalah “Solusi satu Chip” yang secara drastis mengurangi jumlah

komponen dan biaya disain (harga relatif murah) (bem.ilkom.unsri.ac.id: 2011).

2.2 Fitur AVR ATMega328

ATMega328  adalah  mikrokontroler  keluaran  dari  atmel  yang  mempunyai

arsitektur  RISC  (Reduce  Instruction  Set  Computer)  yang  dimana  setiap  proses

eksekusi  data  lebih  cepat  dari  pada  arsitektur  CISC  (Completed  Instruction  Set

Computer).

Mikrokontroler ini memiliki beberapa fitur antara lain:
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1. 130 macam instruksi  yang hampir  semuanya dieksekusi  dalam satu  siklus

clock.

2. 32 x 8-bit register serba guna.

3. Kecepatan mencapai 16 MPS dengan clock 16 MHz.

4. 32  KB  Flash  memory dan  pada  arduino  memiliki  bootloader  yang

menggunakan 2KB dari flash memori sebagai bootloader. Memiliki EEPROM

(Electrically  Erasable  Programmable  Read  Only  Memory)  sebesar  1  KB

sebagai tempat  penyimpanan data  semi permanent  karenaa EEPROM tetap

dapat menyimpan data meskipun catu daya dimatikan.

5. Memiliki pin I/O digital sebanyak 14 pin 6 diantaranya PWM (Pulse Width

Modulation) output.

6. Master / Slave SPI Serial interface.

Mikrokontroler ATMega328 memiliki arsitektur Harvard, yaitu memisahkan

memori untuk kode program dan memori untuk data sehingga dapat memaksimalkan

kerja dan  parallelism.  Instruksi-instruksi dalam memori program dieksekusi dalam

satu  alur  tunggal,  dimana pada  saat  satu  instruksi  dikerjakan instruksi  berikutnya

sudah diambil dari memori program. Konsep inilah yang memungkinkan instruksi-

instruksi dapat dieksekusi dalam satu siklus clock.

32 x 8-bit register serba guna digunakan untuk mendukung operasi pada ALU

(Aritmatika  Logic  Unit)  yang  dapat  dilakukan  dalam  satu  siklus.  6  dari  register

sebaguna  ini  dapat  digunakan  sebagai  3  buah  register  pointer  16-bit  pada  mode

pengalamatan tak langsung untuk mengambil data pada ruang memori data. Ketiga

register pointer 16-bit ini disebut dengan register X (gabungan R26 dan R27), register

Y (gabungan R28 dan R9), dan register Z (gabungan R30 dan R31).

Hampir semua instruksi AVR memiliki format 16-bit. Setiap alamat memori

program terdiri dari instruksi 16-bit atau 32-bit. Selain register serba guna di atas,

terdapat register lain yang terpetakan dengan teknik memory mapped I/O selebar 64

byte. Beberapa register ini digunakan untuk fungsi khusus antara lain sebagai register

control Timer /  Counter, Interupsi,  ADC, USART, SPI, EEPROM, dan fungsi I/O
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lainya.  Regiser-register  ini  menempati  memori  pada  alamat  0x20h  –  0xFh.

(repository.usu.ac.id:2012).

Gambar 2.1 Architecture ATMega328
(Sumber: http://duinoworks.bakketti.com/)

2.3 Konfigurasi PIN ATMega328

Gambar 2.2 Konfigurasi Pin ATMega328

http://duinoworks.bakketti.com/
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(Sumber : Jurnal Syahid tahun 2012 halaman 34)

Table 2.1 Konfigurasi Port B

Tabel 2.2 Konfigurasi Port C
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Tabel 2.3 Konfigurasi Port D

2.4 Komunikasi Serial Mikrokontroler

Komunikasi  Serial  adalah  komunikasi  yang pengiriman data  per-bit  secara

berurutan  dan  bergantian.  Komunikasi  ini  mempunyai  kelebihan  yaitu  hanya

membutukan  satu  jalur  dan  kabel  yang  sedikit  dibandingkan  dengan  komunikasi

paralel.  Pada  prinsipnya  komunikasi  serial  merupakan  komunikasi  dimana

pengiriman data  dilakukan per  bit  sehinga  lebih lambat  dibandingkan komunikasi

paralel,  atau  dengan  kata  lain  komunikasi  serial  merupakan  salah  satu  metode

komunikasi data dimana hanya satu bit data yang dikirimkan melalui seuntai kabel

pada  satu  waktu  tertentu.  Pada  dasarnya  komunikasi  serial  adalah  kasus  khusus

komunikasi paralel  dengan nilai n = 1, atau dengan kata lain adalah suatu bentuk

komunikasi paralel dengan jumlah kabel hanya satu dan hanya mengirimkan satu bit

data secara simultan.  Hal  ini  dapat disandingkan dengan komunikasi paralel  yang
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sesungguhnya di mana n-bit data dikirimkan bersamaan, dengan nilai umumnya 8 ≤

n ≤ 128.

Komunikasi  serial  ada  dua  macam,  asynchronous serial  dan  synchronous

serial. Synchronous serial adalah komunikasi dimana hanya ada satu pihak (pengirim

atau penerima) yang menghasilkan  clock dan mengirimkan  clock tersebut bersama-

sama  dengan  data.  Contoh  pengunaan synchronous serial  terdapat  pada  transmisi

data keyboard. Asynchronous serial adalah komunikasi dimana kedua pihak (pengirim

dan  penerima)  masing-masing  menghasilkan clock namun  hanya  data  yang

ditransmisikan,  tanpa  clock.  Agar  data  yang  dikirimkan  sama  dengan  data  yang

diterima,  maka kedua frekuensi  clock harus sama dan harus  terdapat  sinkronisasi.

Setelah  adanya  sinkronisasi,  pengirim  akan  mengirimkan  datanya  sesuai  dengan

frekuensi  clock penerima.  Contoh  penggunaan  asynchronous  serial  adalah  pada

Universal Asynchronous Receiver Transmitter (UART) yang digunakan pada serial

port (COM) komputer.

Antarmuka kanal serial lebih kompleks/sulit dibandingkan dengan antarmuka

melalui kanal paralel, hal ini disebabkan karena :

1. Dari segi perangkat keras : adanya proses konversi data paralel menjadi serial

atau  sebaliknya  menggunakan  piranti  tambahan  yang  disebut  UART

(Universal Asynchronous Receiver Transmitter).

2. Dari segi perangkat lunak : lebih banyak register yang digunakan atau terlibat.

Namun di  sisi  lain  antarmuka kanal  serial  menawakan beberapa  kelebihan

dibandingkan secara paralel, antara lain :

1. Kabel  untuk  komunikasi  serial  bisa  lebih  panjang  dibandingkan  dengan

paralel; data-data dalam komunikasi serial dikirimkan untuk logika ‘1’ sebagai

tegangan -3 s/d -25 volt dan untuk logika’0’ sebagai tegangan +3 s/d +25 volt,

dengan  demikian  tegangan  dalam  komunikasi  serial  memiliki  ayunan

tegangan  maksimum 50 volt,  Hal  ini  menyebabkan  gangguan  pada  kabel-

kabel panjang lebih mudah diatasi dibandingkan pada paralel.
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2. Jumlah kabel serial lebih sedikit; Anda bisa menghubungkan dua perangkat

komputer  yang  berjauhan  dengan  hanya  3  kabel  untuk  konfigurasi  null

modem,  yaitu  TxD  (saluran  kirim),  RxD  (saluran  terima)  dan  Ground,

bayangkan jika digunakan teknik paralel akan terdapat 20 – 25 kabel. Namun

pada  masing-masing  komputer  dengan  komunikasi  serial  harus  dibayar

“biaya” antarmuka serial yang agak lebih mahal.

3. Banyaknya  piranti  saat  ini  (palmtop,  organizer,  hand-phone  dan  lain-

lain)menggunakan teknologi infra merah untuk komunikasi data, dalam hal ini

pengiriman datanya dilakukan secara serial.  IrDA-1 (spesifikasi infa merah

pertama)  mampu  mengirimkan  data  dengan  laju  115,2  kbps  dan  konsep

komunikasi  serial  dibantu  dengan  piranti  UART,  hanya  panajang  pulsa

berkurang menjadi 3/16 dari standar RS-232 untuk menghemat daya.

4. Untuk teknologi  embedded system,  banyak mikrokontroler  yang dilengkapi

dengan  komunikasi  serial  (baik  seri  RISC  maupun  CISC)  atau  Serial

Communication Interface  (SCI); dengan adanya SCI yang terpadu pada IC

mikrokontroler  akan  mengurangi  jumlah  pin  keluaran,  sehingga  hanya

dibutuhkan 2 pin utama TxD dan RxD (di luar acuan ground) (arifzakariya:

2012). 

2.5 Arduino Uno 

Arduino  Uno  adalah  arduino  board  yang  menggunakan  mikrokontroler

ATmega328. Arduino Uno memiliki 14 pin digital (6 pin dapat digunakan sebagai

output PWM), 6 input analog, sebuah 16 MHz osilator kristal, sebuah koneksi USB,

sebuah konektor  sumber tegangan,  sebuah header  ICSP, dan sebuah tombol reset.

Arduino  Uno  memuat  segala  hal  yang  dibutuhkan  untuk  mendukung  sebuah

mikrokontroler. Hanya dengan menhubungkannya ke sebuah komputer melalui USB

atau  memberikan  tegangan  DC dari  baterai  atau  adaptor  AC ke  DC sudah  dapat

membuanya  bekerja.  Arduino  Uno  menggunakan  ATmega16U2  yang  diprogram
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sebagai USB-to-serial converter untuk komunikasi serial ke computer melalui port

USB. Gambar dari arduino uno dapat dilihat pada Gambar 2.3. 

Adapun data teknis board Arduino UNO R3 adalah sebagai berikut: 

 Mikrokontroler : ATmega328 

 Tegangan Operasi : 5V

 Tegangan Input (recommended) : 7 - 12 V 

 Tegangan Input (limit) : 6-20 V 

 Pin digital I/O : 14 (6 diantaranya pin PWM) 

 Pin Analog input : 6 

 Arus DC per pin I/O : 40 mA 

 Arus DC untuk pin 3.3 V : 150 mA 

 Flash Memory : 32 KB dengan 0.5 KB digunakan untuk bootloader 

 SRAM : 2 KB 

 EEPROM : 1 KB 

 Kecepatan Pewaktuan : 16 Mhz 

Gambar 2.3 Arduino Uno R3 
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(Sumber:http://www.adafruit.com/blog/2012/05/25/handy-arduino-r3-
pinout-diagram/)

2.5.1 Pin Masukan dan Keluaran Arduino Uno 

Masing-masing  dari  14  pin  digital  arduino  uno  dapat  digunakan  sebagai

masukan  atau  keluaran  menggunakan  fungsi  pinMode(),  digitalWrite()  dan

digitalRead().  Setiap  pin  beroperasi  pada  tegangan  5  volt.  Setiap  pin  mampu

menerima  atau  menghasilkan  arus  maksimum  sebasar  40  mA  dan  memiliki  10

resistor  pull-up  internal  (diputus  secara  default)  sebesar  20-30  KOhm.  Sebagai

tambahan, beberapa pin masukan digital memiliki kegunaan khusus yaitu: 

 Komunikasi serial: pin 0 (RX) dan pin 1 (TX), digunakan untuk menerima(RX)

dan mengirim(TX) data secara serial.

 External  Interrupt:  pin 2 dan pin 3,  pin ini  dapat  dikonfigurasi  untuk memicu

sebuah interrupt  pada nilai  rendah,  sisi  naik atau turun,  atau pada saat  terjadi

perubahan nilai. 

 Pulse-width modulation (PWM): pin 3,5,6,9,10 dan 11,  menyediakan keluaran

PWM 8-bit dangan menggunakan fungsi analogWrite(). 

 Serial  Peripheral  Interface (SPI):  pin 10 (SS),  11 (MOSI),  12 (MISO) dan 13

(SCK), pin ini mendukung komunikasi SPI dengan menggunakan SPI library. 

 LED: pin 13, terdapat built-in LED yang terhubung ke pin digital 13. Ketika pin

bernilai  HIGH maka LED menyala, sebaliknya ketika pin bernilai LOW maka

LED akan padam. 

Arduino Uno memiliki 6 masukan analog yang diberi label A0 sampai A5, setiap

pin menyediakan resolusi sebanyak 10 bit (1024 nilai yang berbeda). Secara default

pin  mengukur  nilai  tegangan  dari  ground  (0V)  hingga  5V,  walaupun  begitu

dimungkinkan untuk mengganti nilai batas atas dengan menggunakan pin AREF dan

fungsi analogReference(). Sebagai tambahan beberapa pin masukan analog memiliki

fungsi  khusus  yaitu  pin  A4  (SDA)  dan  pin  A5  (SCL)  yang  digunakan  untuk
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komunikasi  Two Wire Interface  (TWI)  atau  Inter  Integrated  Circuit  (I2C) dengan

menggunakan Wire library. 

2.5.2 Sumber Daya dan Pin Tegangan Arduino Uno 

Arduino uno dapat diberi daya melalui koneksi USB (Universal Serial Bus)

atau melalui power supply eksternal. Jika arduino uno dihubungkan ke kedua sumber

daya tersebut secara bersamaan maka arduino uno akan memilih salah satu sumber

daya secara otomatis untuk digunakan. Power supplay external (yang bukan melalui

USB) dapat berasal dari adaptor AC ke DC atau baterai. Adaptor dapat dihubungkan

ke  soket  power  pada  arduino  uno.  Jika  menggunakan  baterai,  ujung  kabel  yang

dibubungkan ke baterai dimasukkan kedalam pin GND dan Vin yang berada pada

konektor POWER. 

Arduino uno dapat beroperasi pada tegangan 6 sampai 20 volt. Jika arduino

uno diberi tegangan di bawah 7 volt, maka pin 5V akan menyediakan tegangan di

bawah 5 volt dan arduino uno munkin bekerja tidak stabil. Jika diberikan tegangan

melebihi 12 volt,  penstabil tegangan kemungkinan akan menjadi terlalu panas dan

merusak arduino uno. Tegangan rekomendasi yang diberikan ke arduino uno berkisar

antara 7 sampai 12 volt. 

Pin-pin tegangan pada arduino uno adalah sebagai berikut: 

 Vin  adalah  pin  untuk  mengalirkan  sumber  tegangan  ke  arduino  uno  ketika

menggunakan sumber daya eksternal (selain dari koneksi USB atau sumber daya

yang teregulasi lainnya). Sumber tegangan juga dapat disediakan melalui pin ini

jika  sumber  daya  yang  digunakan  untuk  arduino  uno  dialirkan  melalui  soket

power. 

 5V adalah pin yang menyediakan tegangan teregulasi sebesar 5 volt berasal dari

regulator tegangan pada arduino uno. 

 3V3 adalah pin yang meyediakan tegangan teregulasi sebesar 3,3 volt berasal dari

regulator tegangan pada arduino uno.
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 GND adalah pin ground. 

2.5.3 Peta Memori Arduino Uno 

Arduino  Uno  adalah  arduino  board  yang  menggunakan  mikrokontroler

ATmega328.  Maka  peta  memori  arduino  uno  sama  dengan  peta  memori  pada

mikrokontroler ATmega328. 

2.5.3.1 Memori Program 

ATMega328 memiliki 32K byte  On-chip In-System Reprogrammable Flash

Memory untuk menyimpan program. Memori flash dibagi kedalam dua bagian, yaitu

bagian  program  bootloader  dan  aplikasi.  Bootloader  adalah  program  kecil  yang

bekerja pada saat sistem dimulai yang dapat memasukkan seluruh program aplikasi

ke dalam memori prosesor.

Gambar 2.4 Peta Memori Program ATMega 328
(Sumber : Repository.usu.ac.id)

2.5.3.2 Memori Data 

Memori  data  ATMega328 terbagi  menjadi  4  bagian,  yaitu  32 lokasi  untuk

register umum, 64 lokasi untuk register I/O, 160 lokasi untuk register I/O tambahan

dan  sisanya  2048  lokasi  untuk  data  SRAM  internal.  Register  umum  menempati

alamat  data  terbawah,  yaitu  0x0000  sampai  0x001F. Register  I/O  menempati  64

alamat  berikutnya  mulai  dari  0x0020  hingga  0x005F.  Register  I/O  tambahan
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menempati  160 alamat  berikutnya mulai  dari  0x0060 hingga 0x00FF. Sisa alamat

berikutnya mulai dari 0x0100 hingga 0x08FF digunakan untuk SRAM internal. Peta

memori data dari ATMega 328 dapat dilihat pada Gambar 2.5.

Gambar 2.5 Peta Memori Data ATMega 328
(Sumber : Repository.usu.ac.id)

2.5.3.3 Memori Data EEPROM 

Arduino uno terdiri dari 1 KByte memori data EEPROM. Pada memori 

EEPROM, data dapat ditulis/dibaca kembali dan ketika catu daya dimatikan, data 

terakhir yang ditulis pada memori EEPROM masih tersimpan pada memori ini, atau 

dengan kata lain memori EEPROM bersifat nonvolatile. Alamat EEPROM dimulai 

dari 0x000 hingga 0x3FF.

2.6 Ethernet Shield

Ethernet  Shield  menambah  kemampuan  arduino  board  agar  terhubung  ke

jaringan komputer. Ethernet shield berbasiskan cip ethernet Wiznet W5100. Ethernet

library  digunakan dalam menulis  program agar arduino board dapat terhubung ke

jaringan dengan menggunakan arduino ethernet shield. 
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Pada ethernet  shield terdapat  sebuah slot  micro-SD, yang dapat  digunakan

untuk menyimpan file yang dapat diakses melalui jaringan. Onboard micro-SD card

reader diakses dengan menggunakan SD library. 

Arduino board berkominikasi dengan W5100 dan SD card mengunakan bus

SPI  (Serial  Peripheral  Interface).  Komunikasi  ini  diatur  oleh  library  SPI.h  dan

Ethernet.h. Bus SPI menggunakan pin digital 11, 12 dan 13 pada Arduino Uno. Pin

digital  10  digunakan  untuk  memilih  W5100  dan  pin  digital  4  digunakan  untuk

memilih SD card. Pin-pin yang sudah disebutkan sebelumnya tidak dapat digunakan

untuk input/output umum ketika kita menggunakan ethernet shield. 

Karena W5100 dan SD card berbagi bus SPI, hanya salah satu yang dapat

aktif pada satu waktu. Jika kita menggunakan kedua perangkat dalam program kita,

hal ini akan diatasi oleh library yang sesuai. Jika kita tidak menggunakan salah satu

perangkat dalam program kita, kiranya kita perlu secara eksplisit men-deselect-nya.

Untuk melakukan hal ini  pada SD card,  set  pin 4 sebagai  output dan menuliskan

logika  tinggi  padanya,  sedangkan  untuk  W5100  yang  digunakan  adalah  pin  10.

Penampakan Ethernet shield dapat dilihat pada Gambar 2.6.

Gambar 2.6 Ethernet shield
(Sumber :http://www.arduino.cc/en/Main/ArduinoEthernetShield)
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2.7 Module Relay

Relay adalah komponen elektronika berupa saklar elektronik yang digerakkan

oleh arus listrik.  Secara prinsip, relay merupakan tuas saklar dengan lilitan kawat

pada batang besi (solenoid) di dekatnya. Ketika solenoid dialiri arus listrik, tuas akan

tertarik karena adanya gaya magnet yang terjadi pada solenoid sehingga kontak saklar

akan menutup. Pada saat arus dihentikan, gaya magnet akan hilang, tuas akan kembali

ke posisi semula dan kontak saklar kembali terbuka. Relay biasanya digunakan untuk

menggerakkan arus/tegangan yang besar (misalnya peralatan listrik 4 A/AC 220V)

dengan memakai arus/tegangan yang kecil (misalnya 0.1 A/12 Volt DC) (Sutiawan,

2011).

Gambar 2.7 Module relay 4 kanal
(Sumber: https://www.tokopedia.com/freelab/relay-4-channel-for-arduino)

Relay  adalah  komponen  listrik  yang  berkerja  berdasarkan  prinsip  induksi

medan  elektromagnetis.  Jika  sebuah  penghantar  dialiri  oleh  arus  listrik,  maka  di

sekitar pengantar tersebut medan magnet. Medan magnet yang dihasilkan oleh arus

listrik  tersebut  selanjutnya  diinduksikan  ke  logam  ferromagnetis.  Penemu  relay

pertama kali adalah Joseph Henry pada tahun 1835 (Elangsakti, 2013).

2.7.1 Dasar-Dasar Relay

Dalam  pemakaiannya  biasanya  relay  yang  digerakkan  dengan  arus  DC

dilengkapi  dengan  sebuah  dioda  yang  di-paralel  dengan  lilitanya  dan  dipasang

terbalik yaitu anoda pada tegangan (-) dan katoda pada tegangan (+). Ini bertujuan



19

untuk mengantisipasi sentakan listrik yang terjadi pada saat relay bergantian posisi

dari on ke off agar tidak merusak komponen di sekitarnya.

Konfigurasi dari kontak-kontak relay ada tiga jenis, yaitu:

 Normally Open (NO), apabila kontak-kontak tertutup saat relay dicatu

 Normally Closed (NC), apabila kontak-kontak terbuka saat relay dicatu

Change Over (CO),  relay  mempunyai  kontak  tengah yang normal  tertutup,  tetapi

ketika relay dicatu kontak tengah tersebut akan membuat hubungan dengan kontak-

kontak yang lain.

Penggunaan  relay  perlu  memperhatikan  tegengan  pengontrolnya  serta

kekuatan relay men-switch arus/tegangan. Biasanya ukuranya tertera pada body relay.

Misalnya  relay  12VDC/4  A  220V,  artinya  tegangan  yang  diperlukan  sebagai

pengontrolnya  adalah  12Volt  DC dan  mampu  men-switch arus  listrik  (maksimal)

sebesar 4 ampere pada tegangan 220 Volt. Sebaiknya relay difungsikan 80% saja dari

kemampuan  maksimalnya  agar  aman,  semakin  rendah  maka  akan  semakin  aman.

Relay jenis lain ada yang namanya reedswitch atau relay lidi. Relay jenis ini berupa

batang kontak terbuat dari besi pada tabung kaca kecil yang dililiti kawat. Pada saat

lilitan  kawat  dialiri  arus,  kontak  besi  tersebut  akan  menjadi  magnet  dan  saling

menempel  sehingga  menjadi  saklar  yang  on.  Ketika  arus  pada  lilitan  dihentikan

medan magnet hilang dan kontak kembali terbuka(off).

2.7.2 Jenis-Jenis Module Relay

Seperti  saklar,  relay  juga  dibedakan  berdasarkan  pole dan throw yang

dimilikinya. Berikut ini penggolongan relay berdasarkan jumlah pole dan throw:

1. SPST (Single Pole Single Throw)

2. DPST (Double Pole Singlle Throw)

3. SPDT (Single Pole Double Throw)

4. DPDT (Double Pole Double Throw)

5. 3PDT (Three Pole Double Throw)
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6. 4PDT (Four Pole Double Throw)

Berikut ini rangkaian dan simbol macam-macam relay tersebut.

Gambar 2.8 Relay jenis Single Pole Double Throw (SPDT)
Sumber : Kilian, Christopher T, Modern Control Technology, (West Publishing Co :

1996)

Timing  relay  adalah  jenis  relay  yang  khusus.  Cara  kerjanya  ialah  sebagai

berikut: jika coil dari  timing relay ON, maka beberapa detik kemudian, baru kontak

relay akan ON atau OFF (sesuai jenis NO/NC contact). Sedang latching relay ialah

jenis  relay  digunakan  untuk  latching atau  mempertahankan  kondisi  aktif  input

sekalipun  input  sebenarnya  sudah  mati.  Cara  kerjanya  ialah  sebagai  berikut:  jika

latch coil diaktifkan, ia tidak akan bisa dimatikan kecuali unlatch coil diaktifkan.

Gambar 2.9 Simbol coil dan contact dari timing relay
Sumber : Rexford, Kenneth B, Electrical Control for Machines, (Delmar Publishers

Inc :1987)
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Gambar 2.10 Simbol coil dan contact dari latching relay
Sumber : Rexford, Kenneth B, Electrical Control for Machines, (Delmar Publishers

Inc :1987)

2.7.3 Prinsip Kerja Module Relay

Prinsip kerja secara umum sama dengan kontaktor magnet yaitu sama-sama

berdasarkan  kemagnetan  yang dihasilkan  oleh  kumparan  coil,  jika  kumparan  coil

tersebut diberi sumber listrik. Berdasarkan sumber listrik yang masuk maka relay di

bagi menjadi 2 macam yaitu relay DC dan relay AC. Besar tegangan DC yang masuk

pada coil relay bervariasi sesuai dengan ukuran yang tertera pada body relay tersebut

diantaranya relay dengan tegangan 6 Volt, 12 Volt, 24 Volt, 48 Volt, sedangan untuk

tegangan AC sebesar 220 Volt.

Relay terdiri dari coil dan contact, coil adalah gulungan kawat yang mendapat

arus listrik, sedangkan contact adalah jenis saklar yang pergerakannya tergantung dari

ada tidaknya arus listrik di  coil.  Contact ada 2 jenis:  Normally Open (kondisi awal

sebelum diaktifkan open),  dan  Normally  Closed  (kondisi  awal  sebelum diaktifkan

close).

Secara sederhana berikut  ini  prinsip kerja  dari  relay:  ketika  coil  mendapat

energi  listrik  (energized),  akan  timbul  gaya  elektromagnet  yang  akan  menarik

armature yang berpegas, dan contact akan menutup. 
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Gambar 2.11 Skema relay elektromekanik
Sumber : Kilian, Christopher T, Modern Control Technology, (West Publishing Co :

1996)

Selain berfungsi sebagai komponen elektronik, relay juga mempunyai fungsi

sebagai  pengendali  sistem.  Sehingga  relay  mempunyai  2  macam  simbol  yang

digunakan pada:

 Rangkaian listrik (hardware)

 Program (software)

Berikut ini simbol yang digunakan:

Gambar 2.12 Rangkaian dan simbol logika relay
Sumber : Kilian, Christopher T, Modern Control Technology, (West Publishing Co :

1996)

2.7.4 Fungsi Relay

Fungsi Relay, yaitu:

1. Kontrol tegangan tinggi rangkaian dengan sinyal bertegangan rendah, seperti

dalam beberapa jenis modem atau audio amplifier.
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2. Kontrol sebuah rangkaian arus tinggi dengan sinyal arus rendah, seperti pada

solenoid starter dari sebuah mobil.

3. Mendeteksi  dan  mengisolasi  kesalahan  pada  jalur  transmisi  dan  distribusi

dengan  membuka  dan  menutup  pemutus  rangkaian  (perlindungan  relay),

sebuah kumparan relay DPDT AC dengan kemasan “ice cube”.

4. Isolasi mengendalikan rangkaian dari rangkaian yang dikontrol ketika kedua

berada  pada  potensi  yang berbeda,  misalnya  ketika  mengendalikan sebuah

perangkat  bertenaga utama dari  tegangan  rendah  switch.  Yang terakhir  ini

sering  digunakan  untuk  mengontrol  pencahayaan  kantor  sebagai  kawat

tegangan  rendah  dapat  dengan  mudah  diinstal  di  partisi,  yang  dapat

dipindahkan sesuai  kebutuhan sering  berubah.  Mereka  mungkin  juga  akan

dikendalikan  oleh  hunian  kamar  detektor  dalam  upaya  untuk  menghemat

energi.

5. Logika  fungsi  sebagai  contoh,  DAN fungsi  boolean  direalisasikan  dengan

menghubungkan relay normal kontak terbuka secara seri, maka fungsi ATAU

dengan  menghubungkan  normal  kontak  terbuka  secara  paralel.  Perubahan-

atau atau Formulir C kontak melakukan XOR (eksklusif atau) fungsi. Fungsi

yang sama untuk NAND dan NOR yang dicapai dengan menggunakan kontak

normal tertutup. Tangga bahasa pemrograman yang sering digunakan untuk

merancang jaringan logika relay.

6. Awal  komputasi.  Sebelum  tabung  vakum  dan  transistor,  relay  digunakan

sebagai  unsur-unsur  logis  dalam komputer  digital.  Lihat  ARRA komputer,

Harvard Mark II, Zuse Z2, dan Zuse Z3.

7. Safety-logika kritis.  Karena  relay  jauh lebih tahan daripada semikonduktor

radiasi  nuklir,  mereka  banyak  digunakan  dalam  keselamatan-logika  kritis,

seperti panel kontrol penanganan limbah radioaktif mesin.

8. Waktu  tunda  fungsi.  Relay  dapat  dimodifikasi  untuk  menunda  pembukaan

atau penutupan menunda satu set kontak. Yang sangat singkat (sepersekian

detik)  penundaan  ini  akan  menggunakan  tembaga  disk  antara  angker  dan
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bergerak blade perakitan.  Arus yang mengalir  dalam disk mempertahankan

medan magnet untuk waktu yang singkat, memperpanjang waktu rilis. Untuk

sedikit  lebih  lama  (sampai  satu  menit)  keterlambatan,  sebuah  dashpot

digunakan.  Sebuah dashpot  adalah  sebuah piston  diisi  dengan cairan  yang

diperbolehkan  untuk  melarikan  diri  perlahan-lahan.  Jangka  waktu  dapat

divariasikan dengan meningkatkan atau menurunkan laju aliran. Untuk jangka

waktu lebih lama, mesin jam mekanik timer diinstal.

2.7.5 Relay Sebagai Pengendali

Salah  satu  kegunaan  utama  relay  dalam  dunia  industri  ialah  untuk

implementasi  logika  kontrol  dalam suatu  sistem.  Sebagai  “bahasa  pemrograman”

digunakan konfigurasi yang disebut ladder diagram atau  relay  ladder logic. Berikut

ini beberapa petunjuk tentang relay ladder logic (ladder diagram):

 Diagram wiring  yang khusus digunakan sebagai bahasa pemrograman untuk

rangkaian kontrol relay dan switching.

 LD Tidak menunjukkan rangkaian hardware, tapi alur berpikir.

 LD Bekerja berdasar aliran logika, bukan aliran tegangan/arus.

Relay Ladder Logic terbagi menjadi 3 komponen :

 Input , yaitu pemberi informasi

 Logic, yaitu pengambil keputusan

 Output, yaitu usaha yang dilakukan

Sebagai awal, pada gambar di bawah dapat dilihat aplikasi  relay  untuk membentuk

gerbang – gerbang logika sederhana (AND, OR, NOT, dan latching).
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Gambar 2.13 Relay untuk membentuk gerbang logika
Sumber : Kilian, Christopher T, Modern Control Technology, (West Publishing Co :

1996)

Sebagai pengendali,  relay  dapat mengatur komponen – komponen lain yang

membentuk suatu sistem kendali di industri,  di antaranya :  switch,  timer,  counter,

sequencer, dan lain – lain. Semuanya adalah komponen – komponen dalam bentuk

hardware. Perhatikan gambar – gambar berikut.

Gambar 2.14 Pneumatic Timer
Sumber : Kilian, Christopher T, Modern Control Technology, (West Publishing Co :

1996)



26

Gambar 2.15 Thermal dan solid state timer
Sumber : Kilian, Christopher T, Modern Control Technology, (West Publishing Co :

1996)

Gambar 2.16 Counter elektromekanik
Sumber : Kilian, Christopher T, Modern Control Technology, (West Publishing Co :

1996)

2.8 Bahasa Pemrograman Arduino 

Arduino  board  merupakan  perangkat  yang  berbasiskan  mikrokontroler.

Perangkat  lunak  (software)  merupakan  komponen  yang  membuat  sebuah

mikrokontroler  dapat  bekerja.  Arduino board akan bekerja  sesuai  dengan perintah

yang ada dalam perangkat lunak yang ditanamkan padanya. 

Bahasa  Pemrograman  Arduino  adalah  bahasa  pemrograman  utama  yang

digunakan  untuk  membuat  program  untuk  arduino  board.  Bahasa  pemrograman

arduino menggunakan bahasa pemrograman C sebagai dasarnya.

Karena  menggunakan  bahasa  pemrograman  C  sebagai  dasarnya,  bahasa

pemrograman  arduino  memiliki  banyak  sekali  kemiripan,  walaupun  beberapa  hal

telah berubah.

2.9 Arduino Development Environment 

Arduino  Development  Environment terdiri  dari  editor  teks  untuk  menulis

kode, sebuah area pesan, sebuah konsol, sebuah toolbar dengan tomol-tombol untuk
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fungsi  yang  umum  dan  beberapa  menu.  Arduino  Development  Environment

terhubung  ke  arduino  board  untuk  meng-upload  program  dan  juga  untuk

berkomunikasi dengan arduino board. 

Perangkat  lunak  yang  ditulis  menggunakan  Arduino  Development

Environment disebut sketch. Sketch ditulis pada editor teks. Sketch disimpan dengan

file berekstensi .ino. Area pesan memberikan memberikan informasi dan pesan error

ketika kita menyimpan atau membuka sketch. Konsol menampilkan output teks dari

Arduino  Development  Environment dan juga menampilkan pesan error  ketika kita

mengkompile sketch.  Pada sudut kanan bawah dari  jendela Arduino  Development

Environment  menunjukkan  jenis  board  dan  port  seriak  yang  sedang  digunakan.

Tombol  toolbar  digunakan  utuk  mengecek  dan  mengupload  sketch,  membuat,

membuka atau menyimpan sketch, dan menampilkan serial monitor.

Gambar 2.17 Arduino development environment
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Berikut ini adalah tombol-tombol toolbar serta fungsinya:

 Verify

mengecek error code program.

 Upload

meng-compile dan meng-upload program ke Arduino board.

 New

menbuat sketch baru.

 Open

menampilkan sebuah menu dari seluruh sketch yang berada di dalam

sketchbook.

 Save

Menyimpan sketch.

 Serial Monitor

membuka serial monitor.

Dalam  lingkungan  arduino  digunakan  sebuah  konsep  yang  disebut

sketchbook, yaitu tempat standar untuk menumpan program (sketch). Sketch yang ada

pada sketchbook dapat dibuka dari menu File > Sketchbook atau dari tombol open

pada  toolbar.  Ketika pertama kali menjalankan arduino development environment,

sebuah direktori akan dibuat secara otomatis untuk tempat penyimpana  sketchbook.

Kita dapat melihat atau mengganti  lokasi dari  direktori  tersebut dari  menu  File >

Preferences. 

Serial  monitor  menampilkan  data  serial  yang  sedang  dikirim dari  arduino

board.  Untuk mengirim data  ke board,  masukkan teks  dan klik  tombol  send  atau

tekan enter pada keyboard. 

Sebelum meng-upload  program, kita perlu mensetting jenis board dan port

serial yang sedang kita gunakan melalui menu  Tools > Board  dan  Tools > Serial
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Port.  Pemilihan  board  berguna  untuk  mengeset  parameter  (contohnya:  kecepatan

mikrokontroler  dan  baud  rate)  yang  digunakan  ketika  meng-compile  dan  meng-

upload sketch. 

Setelah memilih board dan port serial yang tepat, tekan tombol upload pada

toolbar atau pilih menu File > Upload. Arduino board akan me-reset secara otomatis

dan proses  upload  akan dimulai.  Pada kebanyakan board,  LED RX dan TX akan

berkedip ketika program sedang di-upload. Arduino development environment akan

menampilkan pesan ketika proses upload telah selesai, atau menampilkan pesan error.

Ketika sedang meng-upload  program, arduino bootloader sedang digunakan,

Arduinp  bootloader  adalah  sebuah  program  kecil  yang  telah  ditanamkan  pada

mikrokontroler  yang  berada  pada  arduino  board.  Bootloader  ini  mengijinkan  kita

meng-upload program tanpa menggunakan perangkat keras tambahan.

2.10 Android SDK

Android  SDK  adalah  tools  API  (Aplication  Programming  Interface)  yang

diperlukan  untuk  mengembangkan  aplikasi  pada  platform  android yang

menggunakan bahasa pemrograman Java. Android merupakan subset perangkat lunak

untuk ponsel yang meliputi sistem operasi,  middleware dan aplikasi kunci yang di-

release oleh Google. Saat ini disediakan Android SDK (Sopftware Development Kit)

sebagai alat bantu dan API untuk mengembangkan aplikasi  pada platform android

menggunakan bahasa pemrograman Java. Sebagai platform Android aplikasi – netral,

Android memberi anda kesempatan untuk membuat Aplikasi yang kita butuhkan dan

bukan merupakan aplikasi bawaan Handphone/Smartphone.

2.11 Android

Android  adalah  sistem  operasi  yang  berbasis  Linux  untuk  telepon  seluler

seperti telepon pintar dan komputer tablet.  Android menyediakan platform terbuka

bagi para pengembang untuk menciptakan aplikasi mereka sendiri untuk digunakan

oleh  bermacam  peranti  bergerak.  Awalnya,  Google  Inc.  membeli  Android  Inc.,
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pendatang  baru  yang  membuat  peranti  lunak  untuk  ponsel.  Kemudian  untuk

mengembangkan Android, dibentuklah Open Handset Alliance, konsorsium dari 34

perusahaan peranti keras, peranti lunak, dan telekomunikasi, termasuk Google, HTC,

Intel, Motorola, Qualcomm, TMobile, dan Nvidia. 

Pada  saat  perilisan  perdana Android,  5  November  2007,  Android  bersama

Open Handset Alliance menyatakan mendukung pengembangan standar terbuka pada

perangkat seluler. Di lain pihak, Google merilis kode–kode Android di bawah lisensi

Apache, sebuah lisensi perangkat lunak dan standar terbuka perangkat seluler. 

Di dunia ini  terdapat dua jenis distributor sistem operasi  Android.  Pertama

yang mendapat dukungan penuh dari Google atau Google Mail Services (GMS) dan

kedua adalah yang benar–benar bebas distribusinya tanpa dukungan langsung Google

atau dikenal sebagai Open Handset Distribution (OHD).

2.11.1 Versi Android
Android  memiliki  banyak  versi  semenjak  dirilis  pertama  kali.  Berikut  ini

merupakan versi–versi yang dimiliki Android (Safaat, 2012:10):

1. Android versi 1.1
Pada tanggal 9 Maret 2009, Google merilis Android versi 1.1 yang dilengkapi

dengan pembaharuan estetis pada aplikasi,  jam alarm, pencarian suara, pengiriman

pesan dengan Gmail, dan pemberitahuan email.
2. Android versi 1.5 (Cupcake)

Berselang sekitar 2 bulan dari versi 1.1 tepatnya pada tanggal 30 April 2009

Android versi 1.5 dirilis. Android versi ini didasarkan pada Linux Kernel 2.6.27. Pada

versi ini terdapat pembaharuan antarmuka dan penambahan fitur–fitur. Permbaharuan

yang dilakukan adalah sebagai berikut:
a. Widget dan folder baru yang dapat ditambahkan ke layar utama.
b. Merekam dan menonton video dengan modus kamera.
c. Menggunggah video langsung ke Youtube melalaui handset.
d. Keyboard pada layar yang dapat disesuaikan dengan sistem.
e. Dukungan Bluetooth A2DP (Advanced Audio Distribution Profile)
3. Android versi 1.6 (Donut)
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Pada tanggal 15 September 2009 Android versi 1.6 dirilis. Pembaharuan yang

dilakukan adalah sebagai berikut:
a. Improvisasi pada Android Market.
b. Kamera, camcorder, dan antarmuka galeri yang terintegrasi.
c. Multi select pada galeri.
d. Dukungan resolusi layar Wide Video Graphics Array.
e. CDMA/EVDO, VPN.
f. Gesture dan Text-to-Speech engine.
g. Teknologi text to change speech.
4. Android versi 2.0/2.1 (Eclair)

Pada tanggal 26 Oktober 2009 Android versi 2.0 dirilis. Pembaharuan yang

dilakukan adalah sebagai berikut:

a. Optimalisasi kecepatan perangkat keras.

b. Dukungan HTML 5.

c. Peningkatan Google Maps 3.1.2

d. Microsoft Exchange Support.

e. Live Wallpaper.

f. Dukungan flash untuk kamera 3,2MP dan digital zoom.

g. Bluetooth 2.1.

5. Android versi 2.2 (Froyo)
Pada  tanggal  20  Mei  2010  Android  versi  2.2  dirilis.  Android  versi  ini

didasarkan pada Linux Kernel 2.6.32. Pembaharuan yang dilakukan adalah sebagai

berikut:

a. Optimasi sistem operasi Android, memori, dan performa.
b. Memungkinkan shortcut untuk aplikasi yang diinginkan.
c. Adanya fasilitas tethering.
d. Dukungan password numeric dan alpha numeric.
6. Android versi 2.3 (Gingerbread)

Pada tanggal 6 Desember 2010 Android versi 2.3 dirilis. Pembaharuan yang

dilakukan adalah sebagai berikut:
a. Perubahan user interface.
b. Mendukung resolusi yang lebih besar.
c. Peningkatan fungsi copy-paste.
d. Terdapat Gyroscope dan sensor.
e. Mendukung mixable audio effects.
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f. Tersedia download manager.
7. Android versi 3.0/3.1/3.2 (Honeycomb)

Android versi  ini  lebih ditujukan untuk  tablet yang memiliki prosesor dan

layar yang lebih besar. Pembaharuan yang dilakukan adalah sebagai berikut:
a. User interface khusus untuk tablet.
b. Mendukung multi prosesor.
8. Android versi 4.0 (Ice Cream Sandwich)

Pada tanggal 19 Oktober 2011 Android versi 4.1 dirilis. Pembaharuan yang

dilakukan adalah sebagai berikut:
a. Lockscreen dengan face recognition.
b. Berbagi informasi dengan NFC (Near Field Communication).
c. Pencarian email secara offline.
9. Android versi 4.1/4.2/4.3 (Jelly Bean)

Android  versi  4.1  merupakan  versi  Android  yang  paling  cepat  dan  halus.

Pembaharuan yang dilakukan adalah sebagai berikut:
a. Peningkatan kebebasan pengguna dalam mengatur home screen.
b. Peningkatan kualitas text-to-speech dan voice typing.
c. Peningkatan kualitas pencarian pada Google.
d. Dukungan Google Now.
10. Android versi 4.4 (Kitkat)

Android versi 4.4 merupakan versi Android yang paling baru. Pembaharuan

yang dilakukan adalah sebagai berikut:
a. Immersive mode
b. Akses kontak langsung dari aplikasi telepon
c. Desain baru
d. Tampilan album art pada lockscreen
e. Multitasking lebih mulus, baterai lebih hemat
f. Emoji dan wireless printing
g. Integrasi lebih mendalam dengan Google Drive

2.12 Eclipse

Eclipse  adalah  sebuah  komunitas  bagi  individu  dan  organisasi  yang  ingin

berkolaborasi  secara  commercially-friendly perangkat  lunak  bersifat  opensource.

Proyek  perusahaan  terfokus  pada  membangun  sebuah  platform pengembangan

terbuka  terdiri  dari  extensible  framework,  tools dan  runtimes untuk  membangun,

menyebarkan dan mengelola perangkat lunak (Eclipse, 2012).
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Android dikembangkan menggunakan Java. Telah banyak beredar Java IDE

seperti  JBuilder  dan  NetBeans.  Namun Open  Handset  Alliance  dan  Google  telah

memilih  menggunakan  Eclipse  sebagai  Java  IDE dalam  pengembangan  Android.

Berikut ini  dijelaskan mengapa Eclipse direkomendasikan sebagai Java IDE untuk

aplikasi Android (DiMarzio, 2008:11):

1. Sesuai dengan karakteristik Android yang terbuka bagi para pengembang, Eclipse

merupakan salah satu yang memiliki fitur lengkap dan gratis dari semua Java IDE

yang ada. Eclipse juga sangat mudah digunakan dengan waktu pembelajaran yang

minimal. 

2. Open  Handset  Alliance  telah  merilis  plugin Android  untuk  Eclipse  sehingga

memungkinkan  untuk  membuat  projek  Android  yang  spesifik,  melakukan

kompilasi, dan menggunakan Android Emulator untuk melakukan debug.

2.12.1 Arsitektur Eclipse

Sejak  versi  3.0,  Eclipse  pada  dasarnya  merupakan  sebuah  kenel,  yang

mengangkat plug-in. Apa yang dapat digunakan di dalam Eclipse sebenarnya adalah

fungsi  dari  plig-in yang  sudah  diinstal.  Ini  merupakan  basis  dari  Eclipse  yang

dinamakan  Rich  Client  Platform (RCP).  Berikut  ini  adalah  komponen  yang

membentuk RCP :

1. Core platform

2. OSGi

3. SWT (Standard Widget Toolkit)

4. JFace

5. Eclipse Workbench

Secara standar Eclipse selalu dilengkapi dengan JDT (Java Development Tools),

plug-in yang membuat Eclipse kompatibel untuk mengembangkan program Java, dan

PDE  (Plug-in  Development  Environment)  untuk  mengembangkan  plug-in baru.

Eclipse berserta plug-in-nya diimplementasikan dalam bahasa pemprograman Java.
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Konsep Eclipse adalah IDE yang terbuka  (open),  mudah diperluas  (extensible)

untuk apa saja, dan tidak untuk sesuatu yang spesifik. Jadi, Eclipse tidak saja untuk

mengembangkan program Java, akan tetapi dapat digunakan untuk berbagai macam

keperluan,  cukup  dengan  menginstal  plug-in yang  dibutuhkan  Apabila  ingin

mengembangkan  program  C/C++  terdapat  plug-in CDT  (C/C++  Developlment

Tools). Selain itu, pengembangan secara visual bukan hal yang tidak mungkin oleh

Eclipse,  plug-in UML2  tersedia  untuk  membuat  diagram  UML.  Dengan

menggunakan PDE setiap orang bisa membuat  plug-in sesuai dengan keinginannya.

Salah satu situs yang menawarkan plug-in secara gratis seperti Eclipse downloads by

project. 

2.13 Wireless Router

Wireless Router digunakan untuk melakukan pengaturan lalu lintas jaringan

dari mobile radio ke jaringan kabel atau dari backbone jaringan wireless client/server.

Biasanya berbentuk kotak kecil dengan 1 atau 2 antena kecil. Peralatan ini merupakan

radio based, berupa receiver dan transmitter yang akan terkoneksi dengan LAN kabel

atau broadband Ethernet. Saat ini beredar di pasaran adalah access point yang telah

dilengkapi dengan router di dalamnya yang biasa disebut wireless router. 

Wireless  Router selain  sebagai  penghubung  (access  point)  untuk  jaringan

Local bisa berfungsi mem-forward IP di luar dalam jaringan Local. Sebagai contoh

kita  mempunyai  IP  192.168.0.1  untuk  jaringan  Local  kita  sedangkan  kita  ingin

jaringan 192.168.0.1 kita tidak tersentuh oleh orang luar dari jaringan local itu. Dari

wireless router kita bias setting sebagai contoh menjadi IP 10..50.10.xxx. Otomatis

client yang mendapat IP dari 10.50.10.1 itu tidak bisa masuk ke jaringan 192.168.0.1. 

Inilah fungsi maksimal dari router yaitu untuk memprotect jaringan lokal kita

sehingga  resiko  data  diambil  oleh  orang  luar  lebih  sedikit.  Jadi  kesimpulannya

wireless router adalah sebuah access point yang berfungsi meneruskan IP Local kita

sedangkan router berfungsi meneruskan IP local kita menjadi IP yang kita inginkan. 
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Wireless Router ini  berfungsi menerima paket  data internet yang diberikan

oleh modem USB sesuai  dengan provider  yang digunakan,  jaringan internet  yang

diterima kemudian dipaancarkan kembali sehingga bisa diterima pada jarak kurang

lebih 50 meter.

Gambar 2.18 Wireless router
(Sumber : http://www.tokosigma.com)

2.14 Modem

Modem  adalah  singkatan  dari  modulator  dan  demodulator.  Modulator

berfungsi  untuk  melakukan  proses  menumpangkan  data  pada  sinyal  informasi  ke

sinyal pembawa agar dapat dikirim ke pengguna melalui media tertentu, proses ini

bisa  disebut  dengan  proses  modulasi.  Pada  proses  ini  data  dari  computer  yang

berbentuk sinyal digital akan diubah menjadi sinyal analog. Sedangkan Demodulator

berfungsi sebagai proses mendapatkan kembali data yang dikirim oleh pengirim. Pada

proses ini  data akan dipisahkan dari  frekuensi  tinggi  dan data  yang berupa sinyal

analog akan diubah kembali menjadi sinyal digital agar bisa dibaca oleh komputer.

Jadi  kesimpulannya fungsi  modem adalah  sebuah perangkat  keras  yang berfungsi

untuk komunikasi dua arah yang merubah sinyal digital menjadi sinyal analog atau

http://www.tokosigma.com/
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sebaliknya  untuk  mengirimkan  pesan  atau  data  ke  alamat  yang  dituju.  Bisa  juga

diartikan sebagai perantara untuk menghubungkan komputer kita ke jaringan internet.

Banyak  jenis-jenis  modem  yang  ada  pada  saat  ini,  jenis  modem  dapat

dibedakan  berdasarkan  pemasangannya  dan  jaringannya.  Jika  berdasarkan

pemasangannya  modem  bisa  dibedakan  menjadi  modem  internal  dan  modem

eksternal :

1. Modem  Internal  merupakan  sebuah  kartu  yang  dipasangkan  pada  slot

motherboard.  Keuntungan modem ini adalah cara pemasangannya mudah dan

harga nya relatif murah.

2. Modem  Eksternal  adalah  modem  yang  dipasang  diluar  komputer,  biasanya

ditancapkan pada slot USB.

Sedangkan  berdasarkan  jaringannya  modem  bisa  dibedakan  menjadi  modem

dengan media kabel dan modem dengan media tanpa kabel.

1. Modem  yang  menggunakan  media  kabel  yaitu  sebuah  modem menggunakan

kabel sebagai media perantaranya ( contoh: TV kabel dan jaringan telepon ).

2. Modem  tanpa  kabel,  modem  ini  menggunakan  media  tanpa  kabel  untuk

perantaranya (contoh: modem GSM, modem CDMA dan lain-lain).

2.15 Flowchart

Menurut Hidayat (2014 : Vol. 4 No. 2) Flowchat atau diagram alir merupakan

sebuah diagram dengan simbol-simbol grafis yang menyatakan aliran algoritma atau

proses yang menampilkan langkah-langkah yang disimbolkan dalam bentuk kotak,

berserta  urutannya  dengan  menghubungkan  masing-masing  langkah  tersebut

menggunakan  tanda  panah.  Diagram  ini  bisa  memberi  solusi  selangkah  demi

selangkah  untuk  penyelesaian  masalah  yang  ada  di  dalam  proses  atau  algoritma

tersebut.

Dalam penulisan  Flowchart dikenal dua model, yaitu  flowchart system dan

flowchart  program.  flowchart  system adalah  bagan  yang  memperlihatkan  urutan

procedure dan proses dari beberapa file di dalam media tertentu, sedangkan flowchart
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program adalah bagan yang memperlihatkan urutan dan hubungan proses dalam suatu

program.

Tabel 2.4 Simbol-simbol Flowchart Standar

Simbol-simbol Keterangan

Simbol dokumen Menunjukkan dokumen input dan 

output baik untuk proses manual, 

mekanik atau computer

Simbol kegiatan manual Menunjukkan pekerjaan manual

Simbol simpanan offline File non-komputer yang diarsip urut 

angka (numerical)

Simbol simpanan offline File non-komputer yang diarsip urut 

huruf (alphabetical)

Simbol simpanan offline File non-komputer yang diarsip urut 

tanggal (cronological)

Simbol proses Menunjukkan kegiatan proses dari 

operasi program komputer

Simbol operasi luar Menunjukkan operasi yang dilakukan

di luar proses operasi komputer
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Simbol pengurutan offline Menunjukkan proses pengurutan data

diluar proses komputer

Simbol pita magnetic Menunjukkan input/output yang 

menggunakan pita magnetik

Simbol hard disk Menunjukkan input/output 

menggunakan hard disk

Simbol diskette Menunjukkan input/ouput 

menggunakan diskette

Simbol drum magnetik Menunjukkan input/output 

menggunakan drum magnetik.

Simbol pita kertas berlubang Menunjukkan input/output 

menggunakan pita kertas berlubang

Simbol keyboard Menunjukkan input/ouput 

menggunakan keyboard

Simbol display Menunjukkan  output yang 

ditampilkan di monitor
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Simbol pitacontrol Menunjukkan penggunaan pita 

kontrol (control tape) dalam batch 

control total untuk  pencocokan di 

proses batch processing
Simbol hubungan komunikasi Menunjukkan proses transmisi data 

melalui channel komunikasi

Simbol garis alir Menunjukkan arus dari proses

Simbol penjelasan Menunjukkan penjelasan dari suatu 

proses

Simbol penghubung Menunjukkan penghubung ke 

halaman yang masih sama atau ke 

halaman lain


